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1. Precautions 

Make sure to read the following precautions carefully before using this product. 

 

 This product generates electronic signals in the frequency range of LF to HF band to perform 

measurements. When using this product, do not use equipment that generates electromagnetic 

waves, such as transceivers, mobile phones, smartphones, microwaves, signal generators, etc. We 

do not guarantee the measurement results obtained with such conditions. 

 Do not disassemble, modify, or open the product. It may cause equipment failures. 

 Do not subject this product to excessive shock or vibration, such as hitting an object or dropping 

it. It may cause equipment failures. 

 This product is not waterproof. Be careful not to expose it to water or moisture. Failure to do so 

may cause excessive heat, ignition, or fire. 

 Do not plug or unplug each of the cables, such as USB, during operation. It may cause failures or 

malfunctions. 

 This product is not dust-proof. Use the product indoors. 

 Do not store the product in high humidity or direct sunlight. 

 Do not store the product in high-temperature areas such as in the car. 

 Do not use the product near any fire, heat or other sources of combustion. 

 If you experience any abnormality, such as abnormal sounds, heat, smoke, etc., turn off the power 

immediately and stop using the product. 

 

European Union Directives 

This equipment complies with the relevant provisions of the Electromagnetic Compatibility Directive 

(2014/30/EU) and the RoHS Directive (2011/65/EU). 

 

Federal Communications Commission (FCC) Emissions Compliance Statement 

This equipment has been tested and found to comply with the limits for a Class B digital device, 

pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 

against harmful interference in a residential installation. This equipment generates, uses and can 

radiate radio frequency energy and, if not installed and used in accordance with the instructions, may 

cause harmful interference to radio communications. However, there is no guarantee that 

interference will not occur in a particular installation. If this equipment does cause harmful 

interference to radio or television reception, which can be determined by turning the equipment off 

and on, the user is encouraged to try to correct the interference by one or more of the following 

measures: 

— Reorient or relocate the receiving antenna. — Increase the separation between the equipment and 

receiver. — Connect the equipment into an outlet on a circuit different from that to which the receiver 

is connected. — Consult the dealer or an experienced radio/TV technician for help. 
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2. Product Overview 

This manual describes how to use the supplied software to operate T8200PRO-G. 

 

Table 1  Software Specification 

Item Description 

Functions Set test items, PASS/FAIL limits 

Perform tests and save in log files 

Perform resonance test 

Perform communication (ID reading) test 

Operation Modes Manual operation 

Digital I/O（DIO） operation (Option: DIO) 

External software control (Option: Control by External Software) 

Output Files Log file （measured values, PASS/FAIL results）: txt 

Waveform images: jpeg 

Waveform data: csv 

System 

Requirements 

Windows7, Windows8.1, Windows10（Microsoft .NET Framework 4.0 

or higher） 

USB2.0 or higher 

Specifications and screenshots are subject to change without notice. 

 

 

The product options are shown in Table 2. In this document, the annotations shown in Table 2 are 

attached to describe the optional functions. 

 

Table 2  Product Options 

Annotation Description 

(Option: DIO) Function to control T8200PRO-G from user’s PLC 

using the isolated I/O interface 

(Option: Control by External Software) Function to control T8200PRO-G from user’s 

application software via the Windows registry 
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3. Installing the Software and USB Driver 

Before operating T8200PRO-G, please install the supplied software and the USB driver. 

 

Installation Procedure 

If an older version has already been installed, uninstall it, then install the latest version.  

 

Insert the supplied CD-ROM into the drive and follow the procedure below: 

 

(1) Double-click "SEUTP.EXE" on the CD-ROM. Installation will start. 

(2) During the installation, the Import Files dialog (Figure 1) will appear. Press the Import button. 

Settings files will be copied. 

(3) When it is complete, press Next to close the dialog. 

 

After installation, a folder as shown in Figure 2 will be created. 

 

 

Figure 3  Import Files 

 

 

USB Driver Installation 

Double-click lpc_driver_setup.exe in the supplied CD-ROM. The installation will begin. 

 

 

(2) 

(3) 
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C：\@T8200PRO-G Root Folder 

  
CalDataFile Calibration data 

  

  
CSVdataLog Waveform data (csv) 

  

  
GraphicImage Image data (jpeg) 

  

  
ItemFile Test setting files 

  

  
MeasureLog Log files 

  

  
MeasureRepeatLog Log files for repeat tests 

  

  
bin Binary files 

  

Figure 4  Folder Structure of the Supplied Software 

 

4. Test Setup 

After installing the software, connect the T8200PRO-G main unit to your computer with the supplied 

USB cable. For details, refer to the Test Setup section in the T8200-G Product Specification. 
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5. Setting Test Items after Installation 

After installation, default test settings are loaded when you start the software for the first time. You 

need to set or confirm each item of Table 3 before performing tests. Once you set your test settings, 

the most recent settings will automatically be loaded for the second time start-up. 

 

Table 3  Mandatory Settings 

Setting Item Page Figure Description 

USB setting p.7  Figure 5 Confirm that T8200PRO-G and this software are 

connected. 

Test Settings Window p.13, 

p.13  

Figure 8, 

Figure 9 

Set the test setting file（test conditions, test items, 

PASS/FAIL limits）. 

Calibration(Normalize) p.13  Figure 8 Perform calibration (normalize) to set the reference 

level of the received signal. 

To check if the system is calibrated correctly, 

perform a trial test with no test target on the probe 

(see Checking if the system is calibrated correctly on 

p.22). 
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6. Top Menu Window 

Start the T8200PRO-G software by double-clicking the desktop icon. The Top Menu (Figure 5) 

appears. Various windows are invoked from this menu. 

 

 

  

 

Figure 5  Top Menu Window 

 

(1) Start  Double-click the T8200PRO icon on the desktop to start the software. 

The Top Menu（Figure 5） appears. 

 

(2) USB Status Confirm that Connected, meaning the software and T8200PRO-G is connected, 

is shown. If the connection fails, “Not connected” will be shown. 

 

(3) USB Port If Not connected, select Auto Select for USB Port, and press the Connect button. 

If it doesn’t work, confirm the following: 

 The main unit and the PC are correctly connected? 

 The USB driver has been installed? 

 Unplug the USB cable, plug it again. Press the Connect button. 

 

(4) Language Switch the language: English/ Japanese 

(5) Exit Finish the software. 

 

(1) 

(2) 

(3) 

(4) 

Start 

Test Settings Window  p. 7 

Set test items and PASS/FAIL limits, 

Perform calibration 

Test Window p.18  

Perform tests 

Recall Log Window p.23  

Read and show log files 

(5) 
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Top Menu, Menu Bar 

File > Import files 

Import test setting files. 

 

File > Delete files 

Delete unnecessary test setting files, log files, image files, and csv files. 

 

Tools > Options 

 

Figure 6  Options Window 

 

 

(1) Waveform thickness Waveform thickness in the Test Window. 

 

(2) Image size 

 

Waveforms in the Test Window will be saved with the 

specified size. 

 

(3) X-axis Specify tick style on the x-axis. 

Default: Default style 

Simple: Simple style (display only min / max values) 

(4) Y-axis Check Autoscale to autoscale the y-axis. If unchecked, 

the entered min and max values will be adopted. 

(1) 

(2) 

(5) 

(6) 

(7) 

(3) 

(4) 



T8200PRO-G_TED003_Ver001                  

 

9 

 

(5) Log file 

 

Check and enter a retention period of saved log files. 

When the period expires, files will be deleted. 

 

(6) Image file 

 

If checked, waveforms in the Test Window will be saved 

as jpeg format. 

 Waveform only： saves waveforms only 

 The whole window： saves the whole window 

Check and enter a retention period of saved image files. 

When the period expires, files will be deleted. 

 

(7) Csv file If checked, waveforms in the Test Window will be saved 

as csv format. 

Check and enter a retention period of saved csv files. 

When the period expires, files will be deleted. 

 

 

 

Tools > Update firmware 

Used for updating the firmware. 

 

Help > About T8200PRO-G 

The software version, the serial number of the product, applied product options are shown. 

 

 

Figure 7  Product Information 
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7. Test Settings Window 

In the Test Settings window (Figure 9, Figure 9), test conditions, test items and PASS / FAIL limits 

are set. Those are saved in a test setting file. When exiting the window, calibration (normalize) will 

be performed if necessary. 

 

Calibration Tab:  test conditions 

In this tab, test conditions such as frequency range, RF power, etc. are set. 

  

 

Figure 8  Test Settings Window, Calibration Tab 

 

(1) Select 

Press the Select button to select a test setting file. A test setting file stores test conditions and 

PASS/FAIL limit values. 

Selecting an existing setting file 

Press the Select button and select a setting file. 

 

(1) 

(2) 

(3) 

(4) 

(5) 

(6) 

(7) 

(8) 

(11) 

(12) 

(9) 

(10) 

(13) 
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Creating a new setting file 

Press the Select button and select any setting file as a template. Enter the filename in the textbox on 

the left side of the Select button. 

 

 

(2) Calibration 

Calibration (normalization) is a process to remove the loss and variation caused by probes, cables 

and the internal circuitry. 

Perform calibration (normalize) with the current main unit, probe (antenna) and settings. 

The settings when the calibration is performed are saved in the current test setting file. 

 

 

 

In the following cases, perform calibration again:  

 Test conditions such as frequency range, RF power have been changed. 

 When using the main unit or a probe which is different from one used when the previous 

calibration was performed.  

 When the temperature of the installation site has changed. 

Daily calibration before use is recommended. 

 

To check if the system is calibrated correctly, perform a trial test with no test target on the probe 

(see Checking if the system is calibrated correctly on p. 11). 

 

 

(3) OK 

Overwrite the current settings to the test setting file and exit the window. 

Calibration (normalize) will be performed automatically if test conditions have been changed. 

 

(4) Cancel 

Exit this window without saving anything. 

 

(5) Wiring 

Select a wiring configuration either transmission or reflection. The hardware switches in the main 

unit will be set accordingly. 

You must connect your test probe properly according to the configuration selected. 

Refer to T8200PRO –G Product Specification for details. 

Sample setting files are downloadable from Testram’s homepage http://www.testram.co.jp 

Put downloaded files in the following folder. 

  C:\@T8200PRO-G\ItemFile 

While calibrating, do not put a test target on the probe. 

http://www.testram.co.jp/
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(6) Frequency band 

Select the frequency band to test. The hardware in the main unit will be switched accordingly. 

If the LF band is selected, a hardware ripple filter is enabled. If you run tests in the frequency range 

less than 1 MHz, select LF band to suppress ripples in waveforms. 

If the LF band is selected, frequencies are shown in kHz, otherwise shown in MHz. 

 

(7) Frequency sweep 

Enter the start and stop frequencies (in MHz for HF band, in KHz for LF band) 

 

(8) Points 

Enter the number of data points for the frequency sweep. 

 

(9) Averaging: number of iterations per frequency, times/frequency 

Enter the number of measurement iterations per frequency. The higher the number, the more 

accurate the measurement result will be, but the measurement time will be longer. 

 

(10) Waveform smoothing 

Specify the number of data points when performing waveform smoothing by moving average. If you 

do not want to perform waveform smoothing, set it to "1". 

 

(11) Delay 

The delay time is the amount of time the main unit waits before measuring the data after the source 

signal is applied to the load at each frequency. 

If the delay time is small compared to the system response time, a distorted measurement response 

is obtained. 

Typical values may be 0.05 ms for HF band, 1 ms for LF band. 

 

(12) RF Power 

Enter the output RF power in dBm. 

 

(13) Calibration date 

The last calibration execution date is displayed. It will be blank if calibration has not been performed 

yet. 
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Judgment Tab:  test items, PASS/FAIL limits 

  

 

Figure 9  Test Settings Window, Judgment Tab 

 

 (12) Enable Resonance Test 

If checked, the resonance test: 

 resonance frequency test, attenuation test, Q factor test, limit test 

will be performed. 

 

(13) Enable PASS/FAIL judge for resonance test 

If checked, the pass/fail judgment by the resonance test will be done. 

 

(14) Test items, PASS/FAIL limits of resonance test 

Set test items and the PASS/FAIL limits for the resonance test 

 Resonance frequency 

 Attenuation at the resonance frequency 

 Q factor 

 Limit values for limit test: minimum attenuation values at the specified frequencies. 

(20) 

(12) 
(13) 

(14) 

(15) 

(17) 

(18) 

(16) 

(19) 
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Limit Test 

The user can define minimum attenuation values at specified frequencies (up to 5 points). T8200PRO-

G performs numeric PASS/FAIL comparisons with the defined limits at those frequencies. PASS 

appears if the trace falls within the defined limits, otherwise, FAIL appears (see Figure 1). 

 

 

Figure 1  Limit Test 

 

(15) Q factor 

Select a Q factor calculation method. 

loaded Q, QL The Q factor of the whole measurement system including the test target, test 

probe, the output resistance of the transmitter circuit and the input 

resistance of the receiver circuit. 

unloaded Q, Qu The derived Q factor of the test target including the probe. 

 

When outputting unloaded Q in the reflection mode, select either under-coupled (loose coupling) or 

over-coupled (tight coupling). 

An under-coupled system means that the input resistance of the test target at resonance frequency is 

less than 50 Ohms (the locus of S11 excludes the origin of the Smith Chart), while an over-coupled 

system means that the input resistance of the test target at resonance frequency is greater than 50 

Ohms (the locus of S11 encloses the origin of the Smith Chart). Refer to T8200PRO-G Product 

Specification for details. 

 

 

PASS

FAIL

PASS

FAIL FAIL

PASS

FAIL

PASS

FAIL

PASS

Point 1

Point 2 Point 3

Point 4

Point 5



T8200PRO-G_TED003_Ver001                  

 

15 

 

If the coil-type probe and test target are used, those are magnetically coupled: 

 

 

(16) Enable communication test 

If checked, communication test (the UID reading test) will be performed. 

 

(17) Enable PASS/FAIL judge for Communication Test 

If checked, pass/fail judgment by UID reading will be done. 

  

 

(18) Communication Protocol 

Select a protocol for the communication test. 

 

(19) RF Power for Communication Test 

Normal Power： Select as a default. 

Low Power： Select this option if the RF power is too strong. 

Custom: If the above two options don’t work out , try this option. 

  

(20) PASS/FAIL alarm 

If checked, PASS/FAIL alarm sounds go off.  

 

 

Under-coupled 

Select this if the magnetic field coupling between the test target and the probe is weak. 

This corresponds to the case where the antenna (coil) size of the target and the probe are greatly 

different, or the distance between them is several mm or more apart. 

Over-coupled 

Select this if the magnetic field coupling between the test target and the probe is strong. 

This corresponds to the case where the antenna (coil) of the test target is almost the same size 

as that of the test probe and those are placed closely. 
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RF Channel 

Up to eight RF channels can be used in one setting file. Test settings and PASS / FAIL judgment values 

can be set independently for each RF channel. 

 

 

Figure 2 RF Channel 

 

(1) RF channels 

Select an RF channel to set. 

 

(2) Paste CH1 settings 

Copy the settings of channel 1 to the currently selected RF channel. 

 

(3) Save current channel 

Save the settings of the currently selected RF channel. If test conditions have been altered, calibration 

[normalization] will be automatically performed. 

 

 

(1) 

(2) (3) 
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Setting Example 

This example shows how to set T8200PRO to the following settings: 

Channel 1: RF Power = -10 dBm 

Channel 2: RF Power = -5 dBm 

 

Procedure （Figure 3） 

(1) Select channel 1. 

(2) Set CH1 RF power and other test items. 

(3) Press the [Calibration] button to perform calibration of channel 1. 

(4) Select channel 2. 

(5) Click the [Paste CH1 setting] button. The settings for channel 1 are copied to channel 2. 

(6) Set CH2 RF power and other test items. 

(7) Press the [Calibration] button to perform calibration of channel 2. 

 

 

Figure 4 RF Channel setting example 

 

(1) 

(2) 

(3) 

(4) 

(5) 

(6) 

(7) 
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8. Test Window 

In the Test Window (Figure 5), measurements based on the current test settings are performed. Test 

results are displayed on the screen. Be sure to confirm that the mandatory setting items (p.18 

 Table 3) have been done before performing tests. 

 

  

 

Figure 6  Test Window 

 

(1) Select Press this button to modify the test settings, or to select another setting 

file. Test Settings Window (p.7) will be invoked. 

(2) Start Press this to perform the test. 

 

(3) Reso. test result 

(4) Comm. test result 

PASS/FAIL result of the resonance test is shown. 

PASS/FAIL result of the communication test is shown. 

PASS： background color in green, FAIL: background color in red 

 

It is strongly recommended that the user perform a trial test with no test target on the probe 

to confirm that the system is calibrated correctly. 

(1) 

 

(2) 

 

(3) 

 

(4) 

 (5) 

 

 

 

(9) 

 (8) 

 

(6) 
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(5) Waveform 

 

The waveform as a result of the frequency sweep is shown. 

 

(6) Limit values for the 

limit test 

The limit values for the limit test are shown in symbols. 

PASS: green symbols, FAIL: red symbols 

(8) Close Close the window. 

 

(9) Tabs 

Tab 

Name 

Description 

Log The recent test results, the same as the current log file, are shown. 

 

Repeat Press Start to test the specified number of times. On completion, the average values 

are shown. Press Stop to abort the test. 

 

Lot No. Check Specify Lot No. to specify your lot number (= log filename). Test results are 

written to the lot file. If unchecked, a default lot number (log filename) will be used. 

  

 

 



T8200PRO-G_TED003_Ver001                  

 

20 

 

DIO (Option: DIO) 

In this tab, you can enable/disable the digital I/O (DIO) interface. Plus, you can see the 

current DIO status on the screen. 

 

 When you press the Start DIO button (1), DIO ONLINE (2) on the left side appears, 

meaning the DIO interface is turned on. The current state of each pin is shown. 

 While the DIO interface is enabled (DIO ONLINE), the Start and Select buttons 

are disabled. 

 Press the Stop DIO button (3) to disable the DIO interface. 

 

 

 

 

DIO interface is disabled (manual-operation mode) 

 

DIO interface is enabled (DIO online mode) 

 

Check 

DUT 

This function is to check the characteristics of the device under test (DUT) repeatedly 

with the number of test points reduced before performing a formal test. 

 

(1) Samples 

The number of data points. 

 

(2) RF Power 

Used to alter applied power while performing continuous frequency sweep. 

 

(1) 

(2) 

(3) 

(1) 

(2) 

(3) 

(4) 
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(3) Y-Axis 

Check Autoscale to set y-axis min / max values automatically. 

If you want to specify the min / max value of y-axis, uncheck Autoscale and enter the 

values. 

 

(4) Start/Stop 

Start / stop continuous frequency sweep. 

 

RFCH Switch the RF channel (RFCH).  

Only calibrated RF channels can be selected. 

 

 

(1) RF Channel 

Click to switch the RF channel.  

Information on the selected RF channel is displayed below the button. 

 

(2) Auto Increment 

If checked, the RF channel is automatically switched to the next channel after each 

test is completed. 

 

 

 

(1) (2) 
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Checking if the system is calibrated correctly 

Perform a test with no test target on the probe, the same condition as when the calibration was 

performed, to confirm that the system is calibrated correctly. 

Confirm the straight line of 0 dB level with little noise (Figure 8). If it’s noisy, start the calibration 

over. 

 

 

Figure 9  A Measured Result with no Test Target on the Probe 
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9. Recall Log Window 

In the Recall Log window (Figure 10), you can choose a log file to show measured results again. 

 

 

    

Figure 11  Recall Log Window 

 

(1) Select Press to select a log file. 

(2) Table of test results The contents of the selected log file are shown. Each row 

corresponds to one measurement. 

When clicked, the waveform corresponding to the row is 

shown. 

(3) Waveform The waveform image is shown if the image is saved. Click it 

to enlarge. Click it again to show it with the original size. 

(4) csv If the waveform is saved in the csv format, this checkbox 

appears. 

(5) Visible If checked, the column associated with the current tab is 

shown. Uncheck it to make the column invisible. 

(6) Filter Enter filtering conditions and press Apply Filter. 

(1) 

(2) 

(3) 

(4) 

(5) 

(6) (7) 

(8) (9) 
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(7) Applied filters Applied filters are shown here. To reset a filter, click the 

checkbox. 

(8) Reset Filter Resets all the applied filters. 

(9) Reset All Resets all the applied filters, plus makes all the columns 

visible. 
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10. Output Files 

Test results are saved in the following files. 

 

Output File Format 

Log File txt 

Repeat Log File txt 

Image Data jpeg 

Csv Data csv 

 

Log File 

Each test result is saved in a log file. If Specify Lot No. in the Lot No. tab (Figure 12) in the Test 

Window is checked, the specified lot number (= log file name) will be used. If unchecked, a default lot 

number (log file name) will be used. 

 

  

Figure 13  Lot No. tab in the Test Window 

 

Table 4  Default Lot Number： Uncheck [Specify Lot No.] 

Log filename YYYY-MM-DD_n.txt 

YYYY: year, MM：month, DD: day, n: serial number（1,2,...） 

 

e.g., ） 2019-12-31_1.txt 

Folder to save C：¥@T8200PRO-G¥MeasureLog 

Log filename will be 

updated 

When the date has changed. 

When the New Log button in the Test Window is pressed. 

The serial number of the filename will be incremented by 1. 

 e.g.）2019-12-31_1.txt → Press New Log → 2019-12-31_2.txt 

Sequence number in the log 

file 

automatically numbered （0, 1, 2, ...） 
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Table 5  User-Specified Lot Number： Check Specify Lot No. 

Log filename [Input to Lot No.].txt 

e.g.） XYZ.txt 

Folder to save C：¥@T8200PRO-G¥MeasureLog 

Filename will be updated When the input to the Lot No. is changed 

Sequence number in the log 

file 

[Input to Serial No.] + 1 for the next test 

Incremented by one for each test 

 

Log File Format 

Figure 14 is the content of a log file. Each line consists of the fields (columns) described in Table 6. 

Upon completion of each test, one line corresponding to the test result will be added. 

 

Table 6  Log File Format 

 Item Example Note 

1 Sequence number 00001  

2 UID reading ID=559C8A04 UID, 

PUPI for Type-B, 

IDm for Felica 

3 Resonance frequency F0=15.736  

4 Attenuation ATT=-4.508  

5 Q factor Q=12.378  

6 PASS/FAIL result of resonance test PASS  

7 PASS/FAIL result of communication 

test 

PASS  

8 Test start time 16:31:57:265  

9 Test setting file HF_Reflection_+5.0dB  

10 PASS/FAIL result for each item of 

resonance test 

00000000 note 1） 

11 PASS/FAIL result for each item of 

communication test 

00 note 2） 

12 1st point attenuation of limit test 10.000MHz(0.000) -0.067  

13 2nd point attenuation of limit test 11.000MHz(0.000) -0.052  

14 3rd point attenuation of limit test 12.000MHz(0.000) -0.099  

15 4th point attenuation of limit test 13.000MHz(0.000) -0.163  

16 5th point attenuation of limit test 14.000MHz(0.000) -0.067  
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Note 1） PASS/FAIL result for each item of a resonance test: 8 bit binary format 

b7 b6 b5 b4 b3 b2 b1 b0 

Resonance 

frequency 

Attenuation Q factor 1st point 

attenuation 

2nd point 

attenuation 

3rd point 

attenuation 

4th point 

attenuation 

5th point 

attenuation 

0/1 0/1 0/1 0/1 0/1 0/1 0/1 0/1 

0: PASS, 1: FAIL 

 

Note 2） PASS/FAIL result for each item of a communication test: 1bit binary format 

b0 

UID 

reading 

0/1 

0: PASS, 1: FAIL 

 

 

 

Figure 15  A Log File 

 

Repeat Log File 

On completion of a repeat test, the result will be saved in a repeat log file. The results are also written 

to the log file. 

 

Repeat log filename [log filename]_RPT.txt 

 

Folder to Save C：¥@T8200PRO-G¥MeasureRepeatLog 

 

Log filename will be updated 

 Same as the log file 

 

Format Same as the log file. On completion, the average values are also 

written. 
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e.g.） 

000001, ID=559C8A04, F0=15.736, ATT=-5.317, Q=15.115, ･････ 

000002, ID=559C8A05, F0=15.716, ATT=-5.317, Q=14.952, ･････ 

000003, ID=559C8A06, F0=15.716, ATT=-5.317, Q=15.096, ･････ 

*Avrg, ,F0=15.723, ATT=-5.317, Q=15.054, , , , , , , , , , , , 

 

 

Image Data 

The image file of each frequency sweep will be saved if the checkbox in the Options Windowis checked. 

 

 

Filename [log filename]_［time］.jpeg 

 

Folder to Save C：¥@T8200PRO-G¥GraphicImage¥[log filename] 

 

Format JPEG 

 

 

 

Csv Data 

The csv file of each frequency sweep will be saved if the checkbox in the Options Window is checked. 

 

Filename [log filename］_[time].csv 

 

Folder to Save C：¥@T8200PRO-G¥CSVdataLog¥[Log filename] 

 

Format  

Column Item Example 

1 Frequency 10.000 

2 Attenuation -0.350 

 

e.g.） 

MHz,dBm 

10.000,-0.394 

10.010,-0.394 

10.020,-0.394 
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11. Communication Test 

The specification of communication test is shown in Table 7. 

  

Table 7  Communication Test Specification 

Item Description 

Protocol ISO14443 TypeA(MIFARE Classic, MIFARE Ultralight) 

ISO14443 TypeB  

Felica 

ISO15693(Tag it HF-I Plus/Pro, I・CODE SLIX2) 

Reading UID PASS if the following can be read: 

 ISO14443 TypeA： UID 

 ISO14443 TypeB： PUPI note 1) 

 Felica：IDm 

 ISO15693： UID 

 

Note 1) Since PUPI is not a card/tag specific value, the obtained value may change with each test 

even for the same card/tag. 
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12. Controlling by External Application (Option: Control by External Software) 

T8200PRO can be controlled from user's application software via the Windows registry. The outline 

of the operation is as follows. 

 

(1) Start Test Window (Figure 16) of T8200PRO and the user’s application software. 

(2) Turn on this function by writing "Initialize" to RsoCommand in the Command key. 

(3) Write "Start" to RsoCommand in the Command key to start a test. 

(4) When the test is complete, RsoMachine in the State key becomes "Ready." 

(5) Read the test results from each item in the Result key. 

(6) Write "Stop" to RsoCommand in the Command key to turn off this function. 

 

 

Figure 17  Activity Diagram of the Registry Control 

本機

Start Test Window

Handle Command

Write Results to Registry

Command key

RsoCommand
(Command)

RsoMachine
(Status)

State key

Start Test
Start

Wait Until Done

Read Results

Enable Registry 

Control 
Initialize

Ready

RsoMachine=ReadyResult key

RsoFreq
(Resonance Freq)

RsoQval
(Q factor) User's Routines

Continue

T8200PRO User's Application SoftwareWindows Registry

Start
User's Application

Disable Registry 
Control

Stop

(1)

(2)

(3)

(4)

(5)

(6)
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Registry Structure 

The registry structure to achieve this function is shown in Figure 18. 

 

HKEY_CURRENT_USER       
      

  Software       

        
    Testram     

        
      T8200PRO   

        
        RESO  

         
          Command  Table 8 
          
          State      Table 9  
          
          Result     Table 10 
          

Figure 18  Registry Structure 

 

 

 

Table 8 Command key items: Write a command in this item. 

Item R/W Value Description 

RsoCommand W 

Initialize Turns on this function: the Windows 

registry control is enabled. 

To switch test setting files, set RsoTestIni 

before executing this command (Figure 19). 

To specify your lot number, RsoLotNo 

should be set in advance. 

Start Start the test. 

LotEnd If RsoLotNo is not set, finishes the current 

lot. A new log file will be created for the 

next test.  

Same as the [New Log] button on the 

LotNo. Tab (p.31). 

Stop Disables the registry control function. 

RsoTestIni W  Enter a test setting file 

RsoLotNo 

W 

 User-specified lot number. 

To apply it, set this value and execute the 

Initialize command. 

If not set, a default lot number will be used. 

RsoSerialNo W  User-specified sequence number. 
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Effective if RsoLotNo is set. 

R: Read by the user application, W: Write by the user application 

Write each value as a string. 

 

Table 9 State key items: The current status is shown. 

Item R/W Value Description 

RsoMachine R 

Stop The registry control function is disabled. 

Execute the Initialize command to enable it. 

Ready The registry control function is enabled. 

Waiting for a command. 

Busy Now processing a command. Wait until it 

becomes Ready. 

R: Read by the user application, W: Write by the user application 

Values are returned as strings. 

 

Table 10  Result key items： The test result will be written, same format as a log file (Table 6) 

Item R/W Value Description 

RsoNumber R  Sequence number 

RsoUid R  UID, PUPI, IDm 

RsoFreq R  Resonance frequency 

RsoLevel R  Attenuation 

RsoQval R  Q factor 

RsoResult R  PASS/FAIL result of resonance test 

RsoComResult R  PASS/FAIL result of communication test  

RsoMeasuredTime R  Test start time 

RsoTestIni R  Test setting file 

RsoDetailResult R  PASS/FAIL result for each item of 

resonance test 

RsoDetailComResult R  PASS/FAIL result for each item of 

communication test 

RsoPoint1Level R  1st point attenuation of limit test 

RsoPoint2Level R  2nd point attenuation of limit test 

RsoPoint3Level R  3rd point attenuation of limit test 

RsoPoint4Level R  4th point attenuation of limit test 

RsoPoint5Level R  5th point attenuation of limit test 
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R: Read by the user application, W: Write by the user application 

Values are returned as strings. 

 

For a sample project, please contact our customer service. 

 

 

 

 

Figure 20  Switching Test Setting Files 
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13. Warranty 

Warranty Period 

Testram warrants the product to be free of defects in materials and workmanship for one year from 

the date of shipment. If any faults or defects found to be the responsibility of Testram occurs during 

use of the product within the warranty period, the product shall be repaired. Please contact our 

customer service below. 

 

 

 

The warranty applies only to the original purchaser. 

 

 

Limitation of Warranty 

The foregoing warranty does not apply to the supplied accessories such as cables, probes, connectors, 

antennas, etc. 

Also, the warranty does not apply to defects/failures resulting from the following cases: 

 Failure occurring from inappropriate storage or handling, carelessness or negligence by the user. 

 Failure caused by the user's hardware or software design. 

 Failure caused by unapproved modifications, etc., to the product by the user. 

 Failure caused by irresistible external forces such as fires or abnormal voltages, and failure 

caused by force majeure such as earthquakes, lightning, wind and water damage. 

 If the product purchased by Buyer are to be resold or delivered to a third party. 

 

Testram Co., Ltd. 

14-29, Higashiterauchi-cho, Toyonaka-shi, Osaka-fu 561-0871 

TEL：06-6821-3557, FAX：06-6821-3561 
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DISCLAIMER 

OTHER THAN AS STATED HEREIN, THE PRODUCTS ARE PROVIDED WITH NO OTHER 

WARRANTIES WHATSOEVER. ALL EXPRESS, IMPLIED, AND STATUTORY WARRANTIES, 

INCLUDING, WITHOUT LIMITATION, THE WARRANTIES OF MERCHANTABILITY, FITNESS 

FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF PROPRIETARY RIGHTS, ARE 

EXPRESSLY DISCLAIMED. 

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED 

BY APPLICABLE LAW, IN NO EVENT SHALL TESTRAM BE LIABLE FOR ANY SPECIAL, 

INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, 

WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS 

INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) 

ARISING OUT OF THE USE OF OR INABILITY TO USE THE SOFTWARE PRODUCTS, EVEN IF 

TESTRAM HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 

TESTRAM SHALL NOT BE LIABLE FOR ANY LOSS OF YOUR SOFTWARE PROGRAMS, YOUR 

DATA OR OTHER INFORMATION. 
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